Circuite Integrate Monolitice pentru Microunde

Proiect

Tema de proiectare

Se proiecteaza circuite pasive realizate in tehnologia prezentata la curs (Plessey). Se foloseste Sonnet
pentru simulare electromagnetica si Advanced Design System pentru simulare de circuit. La sfarsitul
semestrului se predd un material care sd descrie componenta implementata, analiza de convergenta,
schema echivalenta si detaliile tehnologice - nr. de straturi/model metal etc. - (format hard sau
electronic pdf/doc) impreuni cu fisicrele care implementeaza proiectul in Sonnet (cel mai precis
proiect din analiza de convergenta, proiect functional - fisierul _X_.son + subdirectorul corespunzator
_X_ din directorul "sondata", versiunea prezenta in laborator, sau ultima versiune evaluativa
disponibila online http://www.sonnetsoftware.com/ ) si Advanced Design System (directorul "*_prj"
corespunzator sau arhiva *.zap a proiectului).

Fiecare tema va contine dimensiuni fizice pentru condensatorul planar (sandwich) cu poliimida ca
dielectric (CPI).

Grila de notare pentru proiect este descrisa in tabelul urmator.

Nr. | Tip componenta Nota

1 | Proiect Sonnet functional cu dimensiunea corecti din 5
tema individuald

2 | Analiza de convergentd in Sonnet (minim 3 dimensiuni +2
pentru celuld), descrisd Tn documentele trimise

3 | Simulare model echivalent in ADS (proiect trimis) +1

4 | Analiza de optimizare in ADS +1

5 | Document +1

Tabel 1. Grila de notare

Nivelul de precizie necesar pentru nota maxima consta in simularea temei in Sonnet utilizadnd o
structura cu 5 straturi (GaAs+Si+P1+Si : Fig. 7a) cu model "Normal metal” (Fig. 2) pentru metalizarile
M2 si M3. Se accepta si utilizarea altor nivele de detaliu in simulare, cu micsorarea notei la utilizarea
unor modele mai simple (mai rapide n simulare) sau cu cresterea acesteia in cazul modelelor mai
complexe (dar mai lente):

Nr. | Descriere Variatie nota | Detalii

1 | Utilizare structura cu trei straturi (GaAs+Pl+aer) -2

2 | Utilizare structura cu cinci straturi (GaAs+Si+PI1+Si) 0 Fig. 1, 7a

3 | Utilizare structura cu noua straturi (GaAs+Si+PI+Si) +1 Fig. 7b

4 | Utilizare metal ideal -2

5 | Utilizare model "Normal metal" 0 Fig. 2

6 | Utilizare model "Thick metal” (min. 4 nivele) +2 Fig. 3,4

7 | Utilizare model "Dielectric Brick™ (min. 2 nivele) +1 Fig. 6,7b

8 | Utilizare Ansys HFSS (studiu individual) +2 "Seminar" pe rf-opto

Tabel 2. Modificare nota


http://www.sonnetsoftware.com/

Note:

Modele mai complicate presupun cresterea considerabila a timpului de calcul si a memoriei
necesare.

Unele combinatii temd/bonus nu sunt posibile. De exemplu: numai modelarea inaltimii
metalizarilor ("Thick metal": Fig. 3,4) poate genera utilizarea a noua straturi dielectrice (Fig.
7b) si utilizarea modelului "Dielectric Brick" (Fig. 6,7b)

Toate componentele implicd utilizarea a doud nivele de metalizare (M2 si M3) si implica
aparitia trecerilor intre nivele (via-holes)

Straturile de materiale implicate sunt reprezentate simplificat in figura 1, indicandu-se de asemenea
suprafetele pe care se depun cele doud niveluri de metalizare M2 si M3 (nitrura de siliciu se depune
deasupra acestor metalizari pentru a evita conexiuni electrice nedorite). Tn tabelul 3 sunt prezentate
caracteristicile materialelor utilizate.
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Fig. 1. Straturi dielectrice

Nr. | Material Er tan & o[S/m] | Rgq[mQ/sq] | h[um]
1 | GaAs 12.85 0.3-10° 200
2 | SisNa4 7.2 15-10°® 0.13
3 | Pl 3.4 55-1073 1.8
4 | M2 3.6-10’ 55 0.5
5 | M3 3.3-107 10 3

Tabel 3. Caracteristici materiale utilizate

Pentru descrierea metalizarilor existd mai multe nivele de detalii introduse, care sunt recompensate
prin bonus-uri diferite (tabelul 2). Tn primul rand modelul utilizat Th Sonnet poate fi:

Metal Ideal (Lossless), pierderi nule, indltime egald cu 0

Modelarea pierderilor (Normal Metal), marimile introduse fiind cele din figura 2: o, h si
raportul de curenti intre suprafata de sus si cea de jos a conductorului. Pierderile sunt modelate
prin rezistente de suprafata, raportul de curenti depinzand de tipul de linii introduse. Pentru
linii microstrip acest raport este tipic 1.5 . In structura geometrica iniltimea introdusi este 0
(valoarea introdusa in model e utilizata strict la calcularea impedantelor de suprafata).
Modelarea pierderilor i a indltimii liniei (Thick metal), marimile introduse fiind cele din
figura 3: o, h si numarul de nivele de metalizare introduse pentru simularea naltimii. Tn

sectionarea stratului dielectric de deasupra pentru a introduce efectiv folii metalice in structura
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(fig. 4). Se obtin astfel cateva (NumSheets -1) suprafete suplimentare, si cateva straturi
suplimentare care permit modelarea mai buna a indlfimii liniei, cu cresterea corespunzatoare a
timpului de calcul si a memoriei necesare, ca urmare se recomandad cresterea gradualda a
numarului de nivele (2 - 4 - 6) cu urmarirea necesarului de memorie si cu realizarea unei
analize de convergenta. In aceasti situatie metalizarea se extinde pe verticala si intra in stratul

dielectric de deasupra.

¥ ' Metal Editor-cuplor_cuadratura_final.son
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Fig. 2. Modelarea pierderilor (Normal metal model)
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Fig; 3. Modelarea grosimii metalizarii (thick metal model)
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Fig. 4. Modelarea grosimii metalizarii (4 nivele)
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Fig. 5. Geometria reald 1n circuitul integrat

Utilizarea modelului "thick metal" oferd apropierea cea mai mare de situatia reald (fig. 5).
Suplimentar, ndltimea stratului de pasivizare cu nitrura de siliciu este mai mica decat a metalizarilor
implicate (0.13um fata de 0.5/3um) ceea ce aduce o dificultate suplimentara la modelarea cu precizie
a depunerii nitrurii de siliciu pe metalizare. O modelare precisa impune introducerea unor straturi
suplimentare si utilizarea modelului "Dielectric Brick". Elementul "Dielectric brick" Tn Sonnet
introduce un paralelipiped dintr-un material dielectric in interiorul unui alt material dielectric,
obligatoriu extins pe intreaga inalfime a stratului dielectric in care se realizeaza introducerea (fig. 6).
Introducerea unui bloc dielectric trebuie insotitd de impunerea unei sectionari pe verticala a stratului
dielectric corespunzator "number of Z-partitions™ (in meniu, Circuit -> Dielectric Layers -> buton Z-
Parts...). Initial valoarea este O pentru straturile "normale", fara blocuri dielectrice, dar trebuie crescut
la minim 1 la introducerea unui astfel de bloc, cu cresterea corespunzatoare a timpului de calcul si a
memoriei necesare, ca urmare se recomanda cresterea gradualda a numarului de nivele (1 - 2 etc.) cu
urmadrirea necesarului de memorie si cu realizarea unei analize de convergenta..
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Fig. 6. Dielectric Brick in Sonnet

Pentru modelarea nitrurii de siliciu depusa pe metalizare e necesara introducerea suplimentara a 4
straturi prin impartirea in trei sectiuni a straturilor de poliimid si aer (pentru a crea nivelele necesare
intre care sa se extinda depunerile de pe metalizare - fig. 7).

has
L ER o
/ ha Ared - - - haz=hs;
’ :i ha1=hwms—hsi
z . | - | -

Dielectric Brick |hrs=hp—hm2

1 el farth
' ] il """:ﬁ:;hlsvlm—ha
7227 74 |v V27 LER
hGaAs hGaAs

Fig. 7. Modelarea pasivizarii pe metalizare (5 straturi -> 9 straturi)

Simularile In Sonnet se realizeaza intre 1 si 20GHz (corespunzator tehnologiei Plessey) si se obtin
pentru utilizarea in analiza de circuit parametrii S pentru dispozitivul analizat. Parametrii S se obtin
in aplicatia Response Viewer unde pot fi afigati parametrii S, dar exista si optiunea exportarii acestor
parametri (in meniu, Output > S,Y,Z Parameter File) cu alegerea optiunilor: Format = Touchstone,
Data Type = De-Embedded, Parameter = S-Param, Complex = Mag-Angle. Prin export se obtine
fisierul *.s2p care poate fi utilizat mai departe in ADS.

Note

e E obligatorie cresterea incrementala a complexitatii modelului ales (nr. de straturi, nr. de
celule, model metal, introducere bloc dielectric, numar de nivele la metalizari si in blocurile

5



dielectrice), deoarece modelarea "completd" depaseste cu mult resursele de timp si RAM pe
care le aveti la dispozitie

Modelarea componentei se face fara introducerea elementelor suplimentare inevitabile in
practica, dar care sunt caracterizate de modele suplimentare: trecere M2/M3 pentru revenirea
pe nivelul de metalizare M3, tranzitii de la linia standard de conexiune (12/40um) la linia
utilizata in circuit, etc. (fig. 8,9).

E necesara adaugarea optiunii "Add reference planes" (neutilizata la laborator) pentru a asigura
obtinerea modelului componentei fara a introduce si liniile (de lungime variabild) de acces
(fig. 8,9).

Dimensiunile celulelor standard sunt:

o bobina: latimea traseelor 12um, spatiul intre trasee 12um, latura trecerilor 40um,
diametru trecere (via) M3-M2 circulara cu diametru 30um, prima spira din jurul trecerii
are latura interna 76pm (fig. 9), linia de acces pe M3 are diverse orientari in functie de
numarul de sferturi de spira din tema.

o condensatoare: latimea liniilor de acces la armaturi (M2 si M3) este de 40um (fig. 8)
Modelarea se incheie prin obtinerea modelului de circuit pentru componentd. Aceasta
operatiune se realizeaza de mai multe ori pe parcursul realizarii proiectului. Analiza de
convergenta presupune urmarirea variagiei unei marimi numerice importante din structura, iar
in cazul componentelor simulate aceastd marime va fi valoarea componentei (marimea
principala, fard componentele parazite, L sau C)

Fig. 8. Modelare condensator, plane de referinta



<

Fig. 9. Modelare bobina, plane de referinta

Modelarea in simulatorul de circuit se realizeaza in ADS (Advanced Design System, versiunea 2003
sau 2009). in principiu pasii sunt:

e modelarea schemei echivalente pentru componentd, prezentata in slide-urile de la curs
impreuna cu relatiile necesare pentru a calcula valorile initiale ale elementelor
e compararea rezultatului (parametri S) cu rezultatele obtinute in Sonnet
e variatia valorilor elementelor din schema echivalentd In vederea suprapunerii in banda larga
(1-20 GHz) a celor doua rezultate
o in cazul alegerii temei cu bobind existd o rezonanta a parametrului Sz; la o frecventa in
interiorul benzii tehnologiei (1-20 GHz). Suprapunerea modelelor se face numai pana
la 80-90% din aceasta frecventa

Programul de simulare utilizat in laborator este Advanced Design System 2003, instalat pe sistemul
de operare XP Professional. In laborator gisiti acest sistem pe o masina virtuala. Detectati pe desktop
icoana care porneste VMware Player. In interfata programului identificati masina virtuala "RF XP

Professional" sau alegeti comanda "Open a Virtual Machine" si cdutati masina in directorul (tipic)
DA\DCMR\WXP_CIM.

& Advanced Design System (Main) Q@@
File View Tools Window Designkit DesignGuide Help
= 9% OB BBk
File Browser
= & default ~
3 X
# £ adaptare_prj
# £ amplificator_prj
& £ ATF_34143 pi
# €3 filtu_pri

# B3 hpeesof

& €3 pr_cimm_prj

# B3 proiect_complet_pij

# £ stub_prj

& £ stub_ser_prj

# & TDSCOMA_BER_PRJ
# €3 transistor_prj v || |Double click to open

k:\users\default\pr_cimm _prj

Fig. 10. Fereastra principala ADS



Fereastra principala a programului - Advanced Design System (Main) (fig. 10) permite gestionarea
proiectelor (creare, stergere, arhivare — in scopul transportului unui proiect pe un alt calculator exista
implementatd o metoda de arhivare format zip, rezultand un fisier cu extensia "*.zap" care va pastra
structura interna de directoare a proiectului), accesul la fisierele individuale ale proiectului. Un proiect
este constituit dintr-un director propriu cu numele "nume ales" + " _prj", aflat in directorul ales la
instalare, implicit "C:\users\default\" dar calea poate fi modificata (si cea implicita, de instalare, si
individual la crearea unui proiect nou).

Nota importanta: Salvarea oricarui fisier in alt director decat cel propus de program (*'networks") in
interiorul directorului proiectului curent (fig. 12) face ca fisierul salvat sa fie decuplat de proiect, cu
alterarea functionalitatii (de ex. o schema salvata in alt director nU va putea fi simulatd).

Pentru a crea un proiect nou utilizati din meniu comanda File > New Project. Aceleasi comenzi pot
fi aplicate utilizand butoanele din bara de comenzi a programului. Tn fereastra care apare se introduce
dupa calea deja afigata "C:\ users\default\" numele dorit al proiectului fara terminatia " _prj" care va fi
adaugata automat de program. Din motive de compatibilitate cu versiunile anterioare, este o cerintd a
programului ca orice cale intalnitd in proiect sa nu contina spatii. Ca urmare numele ales pentru proiect
trebuie ales fara spatii, ca si calea spre director (nu se pot utiliza locatii ca "My Documents" sau
"Desktop™). Exemplu: C:\users\default\popescu5401

New Project

Name

C:\ADS 20038 \users\default\popescus401 Browse...

Project Technology Files:

IADS Standard: Length unit--millimeter ;'J Yiew Details...
Cancel Help

Fig. 11. Crearea unui nou proiect

Se creeaza astfel proiectul respectiv, care este deschis automat. Implicit se creeaza si o prima schema,
ntr-o fereastra noua care poate fi utilizata pentru a desena schema ce urmeaza a fi simulata. In caz ca

aceasta fereastra nu a fost creatd se poate alege butonul I pentru a genera aceastd schema sau

comenzile File > New Design din meniu. Este recomandat sa se salveze aceasta schema (fereastra

[popescu5401_prj] untitledl) | [ﬂ pentru a avea un nume ce poate fi recunoscut. Dupa salvare figierul

corespunzator va putea fi gasit in sectiunea networks din structura proiectului (fereastra principala -
Main - fig. 10,12) in caz ca il veti inchide din greseala.

Ca si Sonnet, ADS este un program multi-fereastra, cu programe individuale care comunica intre ele,
astfel cad va puteti gasi frecvent in situatia in care aveti 4 ferestre deschise simultan (fereastra
principald, una sau mai multe scheme, simulatorul - fig. 15, programul de vizualizare a rezultatelor -
fig. 16).
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Fig. 12. Structura interna (obligatorie) a unui proiect si introducerea schemei

ADS are componentele grupate pe palete pozitionate in partea stanga a interfetei, gruparea fiind in

functie de tipul componentei respective. Pentru introducerea schemei din aceasta lucrare se vor folosi
paletele (fig. 13):

e Lumped Components - Elemente concentrate (RLC)
e Simulation S_Param - elementele de control al analizei, parametri S in acest caz, deoarece
analiza electromagnetica cu care se compara schema ofera numai acesti parametri
e Data Items - pentru introducerea rezultatelor analizei electromagnetice, un diport caracterizat
prin fisierul cu parametri S obtinut in Sonnet

e Optim/Stat/Yield/DOE pentru implementarea algoritmilor de variatie a elementelor din

schema

Elementele comune, des intélnite pot fi accesate din bara de butoane a programului de desenare a
schemei (masa, fire, variabile, etc.)
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Se introduce schema (din fig. 14) prezentata la curs, valorile initiale fiind obtinute cu ajutorul relatiilor
de la curs (schema si valorile sunt diferite in functie de tema aleasa).

VYN | )
" —) | —AAN 2
ol R o RE ;o b
L_M2 i RES L_M3
, e , - C_PRIME : =10 ,
S Term L_vO'Ov186 m:[r TARC A C=0.8459 pF R=1.5418 Ohm 1 ¢ = Term
S |tem2 | cme o c_Mm3 | S | Temi
Num=2 =~ C=0.0673 pF et - C=0.0101 pF Num=1
Z=50 Ohm - - - | Z=50 Ohm
_1;_ = e —_—
* . e T o @ S-PARAMETERS I
Term L3 + Term
Term3 Termé4 a :
% Num=3 : % Num=4 ;E)F;alam
Z=50 Ohm Z=50 Ohm Start=1.0 GHz
_I._ I S ‘_*_ . Stop=20 GHz
= = = Step=0.1 GHz .
S2P
SNP1

File="C:\users\default\pr_cimm_prj\data\Sparam\cap_2uC_4NS_1NZ_param1.s2p"

Fig. 14. Verificarea schemei echivalente pentru comparatia cu rezultatul analizei electromagnetice

Notal: Are importanta pozitionarea corecta a porturilor astfel incat sa corespunda cu notatia porturilor
in Sonnet, mai ales la schemele asimetrice (bobina si condensator PI). De exemplu in figurile 8,9 Tn

Sonnet si 14 in ADS portul 1 (elementul Term cu "Num = 1") este pe nivelul de metalizare M3 iar
portul 2 este pe nivelul M2.

Nota2: Chiar dacd unele valori pot fi modificate direct pe schema, se recomanda utilizarea interfetei

proprii pentru fiecare element pentru introducerea valorilor, interfata accesibild prin dublu-click pe
elementul respectiv.

Urmeaza simularea efectiva 2¢ | sau F7 sau comanda din meniu Simulate > Simulate. Deoarece

este o simulare de circuit, cu modele corespunzatoare dispozitivelor, va puteti astepta ca simularea sa
dureze putin, de ordinul secundelor. Fereastra simulatorului prezentatd mai jos (fig. 15) raméane
deschisd. Urmadriti mesajele pentru a identifica un eventual mesaj de eroare. Daca e cazul, incercati sa
il interpretati si sd corectati eroarea, in caz de insucces apelati la ajutorul cadrului didactic.
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RES.R = 1.38324

L_M2.L = 30.46e-12
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| |

OptPak Status: Optimization termination due to zero gradients. ..
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Fig. 15. Simulatorul ADS
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| Cancel | Help
]
< | >

Fig. 16. Programul de vizualizare ADS

Dupa terminarea cu succes a analizei se va deschide fereastra de vizualizare a rezultatelor (fig. 16).
Vi intereseaza sa reprezentati parametrii S pentru rezultatele din Sonnet si pentru schema echivalenta,
pe acelasi grafic, deci veti alege in momentul plasérii graficului rectangular pe ecran S(1,1) si
reprezentarea modulului (in dB). Se compara reflexia la intrare, nivelul de metalizare M3, pentru
ambele scheme (portul 1 pentru schema echivalenta, portul 3 pentru parametrii S importati) deci
S33/S11, §i transmisia intre intrare si iesire (iesirea e pe nivelul de metalizare M2, portul 2 pentru
schema echivalenta, portul 4 pentru parametrii S importati) deci S43/So1 (fig. 17).
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Fig. 17. Compararea simularii de circuit cu simularea electromagnetica pentru condensator PI

Scopul analizei va fi determinarea valorilor de componente care sa conduca la suprapunerea cat mai
exacta a celor doud grafice. Aceastd metoda de generare a modelelor poate fi la modul general aplicata
si dacd setul de referintd este obtinut Tn urma masuratorilor si nu din simulari electromagnetice.

Algoritmii de optimizare necesita (pentru indicatii suplimentare vezi Lucrarea 5 TAPSR — RD an 1):

e indicarea elementelor care urmeaza a fi modificate,
e alegerea unei metode de modificare/mod de calculare a abaterii fata de tinta, si
e indicarea obiectivului ce trebuie atins (goal)

Pentru a indica ce elemente trebuiesc modificate, se acceseaza interfata proprie fiecarui element (R,
L, C - fig. 18 - butonul "... Optimization ...") si apoi interfata de optimizare, unde trebuie activat
("Enabled") respectiva componenta/valoare, urmat de limitarea intervalului de variatie al componentei
(posibilitatea variatiei nelimitate - "Unconstrained” - desi existenta in interfata, nu este recomandabila
intr-un procedeu de optimizare). Tinand cont de faptul ca relatiile de la curs ofera deja niste valori
estimate, se poate defini 1n jurul lor un interval (min/max) sau o abatere procentuald sau absoluta in
jurul valorii de start. Alegerea (fig. 18) a unui interval, are avantajul obtinerii unor limite cu valoare
numerica "rotunda" usor de remarcat in situatia in care o componenta ajunge sa atinga aceste valori in
urma procesului de optimizare (situatie care indicd necesitatea schimbarii intervalului).
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i---;E-E'
e
. . C.PRIME .
.. C=08459 pF
(M2 e o
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Optimization St |Enabled . ’
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min/max bl

Nominal Value

0.8459 F
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i
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pF
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/[ H

|~ Post Production Tuning

0K Apply Cancel Reset

Fig. 18. Definirea vari

Help
52P

el e

abilelor

_o | e | ceel| ey

0K Cancel Help

si a intervalului de variatie ADS 2003/2009

Se remarca faptul ca versiunile de ADS de dupa ADS 2009 beneficiaza suplimentar de o varianta

imbunatatita de a vizualiza si modifica variabilele utilizate in procesele de optimizare, accesibila din
meniu Simulate > Simulation Variables Setup (fig. 19)

48 Simulation Variables Setup PR
[ Tuning | Optimization | Statistis | DOE |
Name Optimize Value ~ Unit  Format Minf+-/+- Unit  Max Unit  Step Unit -
4 indic_optim
4 SNPL
Te. [ 210 Unconstrained
4 Terml
| z B 0 Ohm  Unconstrained
[ 4 Term2
z B % Ohm  Unconstrained
PR |
c @ 0001 pF min/max 0001 pF 01 Pk |
PRRY 401
L @ 00375 oM min/max 0005 nH 01 nH
4 RES
R [@ 1548  Ohm  min/max 01 Ohm 5 Ohm f
4 CPRL. |
c ® 08459  pF min/max 01 pF 5 oF [ W
PR
C @ 00673 pF min/max 0001 pF 03 Pk [
PR |
L @ 0018 nH min/max 0005 nH 01 nH |
4 VARL LN
d. [ o001 Unconstrained
[l dphs [[] 01 Unconstrained
fmin [[]  1GHz Unconstrained
fmax [] 20GHz Unconstrained o
7] Show only selected instances [uncheckan ] [ ok | [ concel |[ heb |

LFig. 19. Definirea variabilelor si a intervalului de variatie (ADS 2009)‘

Dupa indicarea elementelor ce urmeaza a fi modificate, in schema (fig. 20) acestea vor putea fi
identificate ca fiind incluse in procesul de optimizare (valoarea elementului este urmata de opt,
impreuna cu indicatii ale intervalului de variatie). Din paleta Optim/Stat/Yield/DOE (fig. 13) se
introduce controler-ul de simulare corespunzator (OPTIM), care, impreuna cu indicarea obiectivelor
procesului de optimizare, va completa schema utilizata in procesul de optimizare (fig. 20).
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L R L
L_M2 RES L M3
L=0.0186 nH opt{ 0.005nHto 0.1 nH} R=15418 Ohm opt{ 0.1 Ohm to 5 Ohm } L=0.0375 nH opt{ 0.005 nH ta 0.1 nH } - l

GOAL | B | - GOAL 1

)

Y Y\ . 3 P o Y .
7 [ OPTIM
c_M3
C_-PRIME C€=0.0101 pF opt{:0.001 pf to 0:1 pF } Qptir
+ + Brm
C_M
I C=0

Goal Goal
S11mag S11phs
Expr="dB(5(1,1))-dB(5(3,3))" Expr="phase(S(1,1))-phase(S(3,3))'

+ E C=0.8459 pF opt{ 0.1 pF to 5 pF } Optim1 . Siminst: Name="SP1" Siminst; Name="SP1"
Term2 2 Term1 OptimType=Gradient _UseAIOpNVars=ygiC o 1n™ o Mi=070hs
Num=2 0673 pF opt{ 0.001 pF to 0.3 pF } Num=1 ErrorForm=L2 UseAllGoals=yes .- 1*dmag Max=0.1*dphs
Z=50 Ohm Z=50 Ohm Maxiters=100 Weight= Weight=

- DesiredError=010 RangeVar{1]="freq"

RangeMin[1]=fmin
RangeMax(1]=fmax

RangeVar(1]="freq"
RangeMin[1]=fmin
RangeMax{1]=fmax

StatusLevel=4
— FinalAnalysis="SP1"
NormalizeGoals=no
SetBestValues=yes
Seed=
SaveSolns=no
SaveGoals=yes: l
SaveOptimVars=na
UpdateDataset=yes
SaveNominal=yes
SaveAllterations=no

GOAL GOAL |

S21mag S21phs
Expr="dB(5(2,1))-dB(S(4,3))" " Expr="phase(5(2,1))-phase(5(4.3))"

tart=1.0 GHz
Stop=20 GHz

~elFals,
T L S-PARAMETERS
Term3 Term4 Parar
Num=3 3 E Num=4 © Py
7=500hm 2250 Ohm 2

= oF = Step=0.1.GHz SiminstanceName="SP1" SiminstanceName="SP1*
an ~ 7 Min=-0.1*dmag Min=-0.1*dphs
N [En] V2 Max=0.1*dmag Max=0.1*dphs.
File="C:\users\default\pr_cimm_prj\data\Sparamicap_2uC_4NS_1NZ_param1.s2p" VART Weight= Weight=
:":‘asg_’nof' RangeVar{1]="freq" RangeVar(1}="freq"
fn’:m:]GHz RangeMin[1]=fmin RangeMin[1]=fmin
fmax=20GHz RangeMax(1]=fmax RangeMax{1]=fmax

Fig. 20. Introducerea procedurii de optimizare (de s‘uplimentat Cu S22)

Pentru controler-ul de optimizare trebuie indicate (fig. 21) metoda de optimizare utilizatd (pentru
problema curentd metodele Gradient sau Random sunt suficiente), variabilele si obiectivele care se
utilizeaza in algoritm si numarul (maxim) de iteratii care trebuie realizate pentru a ajunge la rezultat.

Nominal Optimization: 3 @ Nominal Optimization:3 @

Optim Instance Name Optim Instance Name
|Optim1 |Dptim1

Setup IPavametevs| Display | Setup  Parameters IDisplay]

Output Data
Optimization Type s I~ Analpsis outputs
Optimization Goal and Variable Setup [V Goal expressions

OptGioal | Optvar | [~ Dptimization variables

[v Use All Goals in Design Output Data Contral
Save data fo iteratio
v Update display during off -
Levels
[ = Status level [
Final Analvsi
< SP1 v >
_cu | Seed I
e
Stopping criterion Desired Error oo
Number of iterations hUU— > [~ Nomalize goals automatically
[V Set best values for parent optimization

% |

VAR

VAR1

Apply Cancel Help 0K Apply Cancel Help

| GOAL I | GOAL I

i Goal Goal
gmhasgz-oobam S21mag S21phs
P! - Expr="dB(S(2,1))-dB(S(4,3))" Expr="phase(S(2,1))-phase(S(4,3))"

fmin=1GHz . o 2 ; 4 0

fmax=20GHz SimInstanceName="SP1 SiminstanceName="SP1
Min=-1*dmag Min=-1*dphs
Max=dmag Max=dphs
Weight= Weight=

RangeVar[1]="freq"
RangeMin[1]=fmin
RangeMax[1]=fmax

RangeVar[1]="freq"
RangeMin[1]=fmin
RangeMax[1]=fmax

Fig. 21. Controlul procedurii de optimizare

In sectiunea "Parameters" se specifica care sunt datele care trebuie salvate (initiale, intermediare,
finale), daca programul de vizualizare asociat va fi activ in timpul simularii sau nu, daca trebuie
realizatd o analiza cu valorile finale obtinute la optimizare. Activarea salvarii unor date intermediare
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sau finale e necesard poate in etapa realizarii proiectului pentru ca permite urmadrirea evolutiei
procesului (permitand eventual oprirea a unei analize care nu se desfagoara in directia necesara).

Obiectivele pentru algoritmul de optimizare (pot fi oricat de multe, dar cresterca numarului acestora
mai mult decat este necesar pentru rezolvarea problemei poate incetini sau chiar face imposibila
obtinerea unui punct optim) se introduc prin introducerea elementului "Goal" din aceeasi paleta
Optim/Stat/Yield/DOE (fig. 13). Elementul "Goal" e caracterizat de o expresie matematicd "Expr"
care nu trebuie sd scadd sub valoarea "Min" sau sd creascd peste valoarea "Max" cand variabila
independenta "RangeVar" (tipic aceasta variabila este frecventa - "freq") variaza intre "RangeMin" si
"RangeMax". Pot fi mai multe variabile independente daca problema de rezolvat o necesita.

In cazul temei curente, se tine cont de faptul ci parametrii S sunt numere complexe, caracterizate de
modul si faza, deci pentru fiecare parametru care se cere modelat in schema apar doud obiective, unul
in care expresia caracterizeaza abaterea modulului, un al doilea in care expresia caracterizeaza
abaterea fazei. Tinand cont ca schema implementata e un circuite reciproc (fara circuite active, ferite)
S12 = So1, deci conditiile de coincidenta trebuie puse doar pentru 3 parametri: S11, S21 si S22 (S22 nu
apare in fig. 20 dar intervine cu doud obiective la fel ca ceilalti parametri S). Pentru a usura
modificarea simultana a tuturor obiectivelor se foloseste un bloc VAR pentru a defini variabile pentru
eroare modul (dmag), eroare faza (dphs), frecventd minima (fmin), frecventd maxima (fmax). O
schimbare in acest bloc va fi automat transferata la toate cele 6 elemente obiectiv "Goal".

Valorile obtinute in urma procesului de optimizare pot fi afisate (varianta recomandata este sub forma
tabelara - fig. 22) si pot eventual fi preluate in schema cu comanda Simulate > Update Optimization
Values (comanda necesara doar daca se utilizeaza mai departe aceste valori, in alte conditii fiind
preferabila pastrarea valorilor initiale Tn schema pentru realizarea unei scheme echivalente pentru un
alt set de parametri S). Numarul de iteratii parcurse poate furniza informatii importante. Astfel,
optimizarea cu metode de gradient cauta un minim al obiectivelor pentru toatd gama de frecventa, in
mod normal la atingerea acestuia procedeul se opreste. Incheierea cu succes a acestui algoritm se poate
observa daci numarul de iteratii parcurs e mai mic decat cel indicat la pasul anterior (fig. 21). Tn caz
contrar trebuie repetatd simularea cu un numar mai mare de pasi, sau cu intervale mai largi pentru
componente, sau cu abatere permisd mai mare. Dimpotriva la optimizarea cu metode aleatorii
(Random) se parcurg toti pasii indicati, fara conditii de oprire, deci numarul de iteratii trebuie sa fie
egal cu cel maxim.

[cCmM2C | CM3C [.PRMEC [ L M2ZL [ L M3L | R [ InitialEF | FinalEF [ Numiters |
[6.001E-14 | 2.732E-15 | B.I04E-13 | 3.046E-11 | 4.697E-11 | 1.383 | 9454 | 0521 | 47.000]

Fig. 22. Valorile optimizate din schema echivalenta pentru condensator PI

Fie prin realizarea unei analize de parametri S finale (fig. 21) fie prin preluarea in schema a valorilor
optimizate si realizarea manuald a unei analize de parametri S, se poate verifica potrivirea intre seturile
de parametri S (fig. 23) si obtine modelul echivalent al componentei simulate/masurate (fig. 24).
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Fig. 23. Rezultatele optimizarii pentru condensator PI

L R L
L_M2 RES L_M3
L=0.03046 nH opt{ 0.005 nH to 0.1 nH } R=1.38324 Ohm opt{ 0.1 Ohm to 5 Ohm }L=0.0469674 nH opt{ 0.005 nH to 0.1 nH }
oYY ; ) I AN/ - OV,
© C_M3
C_PRIME C=0.00273142 pF opt{ 0.001 pF to 0.1 pF }
+ Term © C=0.890412 pF opt{ 0.1 pF to 5 pk } +*  Term
Term2 C_M2 Term1
Num=2 >~ C=0.0600054 pF opt{ 0.001 pF to 0.3 pF ¥~ Num=1
Z=50 Ohm Z=50 Ohm
i I

I}

Fig. 24. Modelul final pentru condensatorul Pl

Exemplu de proiectare

Sa se proiecteze un condensator planar (sandwich) cu poliimida cu latura armaturii de X pm.

Se incearca obtinerea notei maxime, deci la nota de baza 6p se adauga bonus-urile pentru "Utilizare
structura cu noua straturi" (+1p, Fig. 7b), "Utilizare model Thick metal" (+2p, Fig. 3,4) si "Utilizare
model Dielectric Brick (+1p, Fig. 6,7b).

Se deseneaza structura in Sonnet conform indicatiilor anterioare. Structura de baza va fi cea
corespunzatoare complexitatii maxime tintite (Fig. 7b), fiind relativ usor de eliminat straturi, blocuri
dielectrice, modificat model de metal pentru a realiza analize simplificate.

O prima alegere care trebuie realizata este cea a dimensiunii celulei, deoarece desenarea se face prin
nodurile unui grilaj existent. Tn acest moment trebuie tinut cont de cum va fi modificata celula pe
viitor, deoarece la modificarea celulei se schimba si grilajul asociat, si € mai comod ca structura
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desenata sa se potriveasca si cu grilajele viitoare, evitand astfel desenarea din nou a structurii de fiecare
data.

Se alege celula cea mai_mare preconizata a fi utilizata ca divizor al laturii armaturii si a altor
dimensiuni din structura, chiar daca numerele rezultate nu vor fi tocmai "rotunde". In continuare orice

injumatatire a celulei va pastra desenul ancorat pe grilaj.

A
\ 4

A
\ 4
A

E

\ 4
Fig. 25. Alegerea dimensiunii maxime a celulei

L:keN A:IeN —=meN —=peN E:(]eN —=reN
CO CO 0 0 CO 0
Ci=C0'2_i—>£=XC'2 =k'eN A=|'eN —=m'eN

i 0 i i

Daca structura o impune, celulele nu trebuie neaparat sa fie patrate, discutia fiind similara dar separata
pe cele doua directii, aparand doua grade de libertate suplimentare

(C,—>Cg. Gy i1, j):

L:keN,AzleN,E:meN,izpeN L:qu,R:reN,£:SeN
Co Co Co Co Co Co 0
C'=Cy-2"; C/=CJ-27% i jeN

Se reaminteste puterea "magica" a puterilor lui 2 1n ceea ce priveste alegerea unei dimensiuni initiale.
Se recomanda indeplinirea, dacd e posibil, ca fiecare din valorile intregi ale rapoartelor din relatiile
anterioare (k, I, m, p, g, r, S) sa fie o putere a lui 2. In acest caz, daca alegerea initiala se dovedeste a
fi prea micd, este posibila dublarea dimensiunii celulei de un numar de ori (variabil) cu pastrarea
conditiei de ancorare a desenului structurii pe nodurile grilajului.
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C, C, C,-2" 2

Regulile amintite creeazd o serie geometrica pentru dimensiunile celulei, utilizdnd 2 ca baza. Orice
numar intreg poate fi folosit ca baza, dar utilizarea unui numar mai mare duce la obtinerea unei scaderi

a celulei mult prea rapida care creste prea brutal memoria si timpul necesare pentru analiza (ex:
1,248,16.../1,3,9,27,81...)

Notd importanti: Sub nici un motiv nu se dezactiveaza optiunea Snap (din meniu Tools > Snap
Setup sau - mai usor de apasat din greseald - din butonul din bard). Daca nu se poate desena
dimensiunea doritd pe grilajul curent, e un semn ca alegerea initiala a celulei a fost gresita.

Pentru schema realizata se alege celula cea mai mare de dimensiune 8pum, patratd, cu indeplinirea
conditiilor anterioare. Vom putea apoi micsora celula prin injumatagire (4pm, 2um, 1um, 0.5um) fara
a mai fi necesara redesenarea structurii. Se utilizeaza frecvent comanda View > View 3D pentru a

verifica pozitionarea corectd a elementelor (Fig. 26 - dupa directia Z scala este exageratd pentru
observarea detaliilor subtiri).

s

we

e

Fig. 26. Structura desenata: 9 straturi (8 nivele), Thick Metal, Dielectric Brick

Urmeaza realizarea unei analize de convergenta pentru a determina nivelul de detalii necesar de a fi
introdus in analizad. Marimea primara de interes pentru dispozitivul simulat este capacitatea primara.
Pentru fiecare analiza electromagnetica se vor salva parametri S intr-un fisier Touchstone care va fi
folosit in ADS pentru optimizarea schemei echivalente si obtinerea parametrilor din schema. Valorile

calculate cu relatiile din curs pentru modelul echivalent (valorile de start din ADS) sunt cele din figura
14:

C _PRIME =0.8459pF,L_M2=0.0186nH, L_M3=0.0375nH
RES =1.5418Q,C _M2=0.0673pF,C_M3=0.0101pF
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E momentul sd mentionam ca tinta analizelor nu va fi sd obtinem exact aceste valori prin simulare,
deoarece caracteristicile tehnologiei Plessey ar putea sa fie putin diferite de caracteristicile mentionate
n tabelul 3.

Investigarea efectului modelarii metalizarilor se face pentru o structura cu celula de 4pm, cu modelul
Thick metal cu un numar variabil de folii metalice (NS = 2,4,8,16), pe o structura fara utilizarca
blocurilor dielectrice (SisNs aplicat pe metalizari) pentru accelerarea analizelor. Vom verifica si
situatia utilizarii unor modele mai putin performante pentru metalizari (NS = 0, metalizare ideala -
LossLess - sau normala - Normal Metal). Pentru aceste modele, trebuie sa tinem cont de disparitia
inal{imii metalizarilor, care nu sunt neglijabile, acest lucru putand fi realizat prin eliminarea straturilor
de dielectric de indltime hpi1 = hm2 — hsisi hai1 = hwms — hsi din figura 7b. Deoarece marimea
capacitatii unui condensator planar depinde explicit de distanta dintre armaturi, Tn acest mod asiguram
cu aproximatie aceeasi 1ndltime de poliimida intre acestea. Rezultatele analizei de convergenta sunt
prezentate 1n tabelul 4 si figura 27.

Nr |Cell [um]| NS | NZ | Mem. [MB] |Timp/f [s] C—F[’EF']ME Obs.

1 4 0 0 8 1 0.8155 0 (LL)

2 4 0 0 8 1 0.8157 0 (NM)

3 4 2 0 49 6 0.8491 2 (TM)

4 4 4 0 94 13 0.8492 4 (TM)

5 4 8 0 226 42 0.8492 8 (TM)

6 4 16 | O 662 170 0.8493 16 (TM)

Tabel 4. Analiza de convergenta, caracteristici metalizari
C_PRIME (Num. Sheets)
0.85 |=-C_PRIME AZ 600
<#-Memorie [MB]
ose Timp/f[s] w00
[pF] i5

0.82 300 §F
" 0 (LL) 0 (NM) 2 (TM) 4 (TM) 8 (TM) 16 (TM) '

Num. Sheets

Fig. 27. Analiza de convergenta, caracteristici metalizari

Analiza de convergenta aratd importanta utilizarii modelului "Thick Metal", dar demonstreaza de
asemenea faptul ca un numar de doua nivele de metalizare ar fi suficiente pentru structura analizat
(cu mai multe nivele apare o variatie a capacitatii dar nu este esentiald). Vom alege totusi 4 nivele de
metalizare pentru a Indeplini conditiile de obtinere a punctelor bonus.
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Investigarea dimensiunii celulei necesara pentru analiza va fi facuta de asemenea in lipsa blocurilor
dielectrice aplicate pe metalizari pentru accelerarea analizelor. Rezultatele sunt prezentate in tabelul
5 si figura 28. Se observa ca variatia capacitatii determinate este de ordinul 0.5% intre celula de 8um
si cea de 0.5um deci o dimensiune de 8um ar putea fi suficientd. Totusi celulele fixate in planele de
metalizare vor genera sectionare corespunzatoare si a blocurilor de dielectric care vor fi aplicate pe
metalizari. Avem anumite informatii legate de necesitatile de memorie si timp de calcul si o indicatie
relativ la valoarea aproximativa a celulei care trebuie utilizatd (~4um) dar o decizie definitiva trebuie
luata cu structura completa (inclusiv cu blocurile de dielectric)

Nr |Cell [um]| NS | NZ | Mem. [MB] |Timpr/f [s] C—F[’SF']ME
1] 8 | 4]0 46 6 0.8483
2| 4 | 4|0 %4 13 0.8492
3| 2 | 4]0 196 42 0.8506
4| 1 | 4]0 422 175 0.8519
5| 05 | 4 | 0 910 795 0.8530

Tabel 5. Analiza de convergentd, dimensiune celula, fara "Dielectric Brick"

C_PRIME (Cell Size)

0.854 1000

0.853 T 200
=-C_PRIME

<#-Memorie [MB]
Timp/f[s] [

800
0.852

700
0.851

600
0.85

[PF]

0.849

500

Memorie [MB]
Timp [s]

400

0.848
300

0.847 200

0.846 100

0.845 0
8 4 2 1 0.5

Cell Size [um]
Fig. 28. Analiza de convergenta, dimensiune celula, fara "Dielectric Brick"

Investigarea efectului partitionarii pe verticala a straturilor de dielectric care vor contine blocuri dintr-
un alt dielectric (model "Dielectric Brick") se face cu o dimensiune a celulei mare (8um), pentru a nu
genera analize excesiv de lungi si consum excesiv de mare de memorie. Rezultatele sunt prezentate
in tabelul 6 si figura 29. Se observa importanta deosebitd pe care o are introducerea blocurilor de
dielectric (in principal stratul depus pe metalizarea M2 care joaca rol de dielectric dintre armaturile
condensatorului), in schimb pentru aceasta structura particulara partitionarea suplimentara pe verticala
a blocului Tn 2 sau mai multe nivele nu aduce deloc modificarea rezultatelor. Deci blocurile de
dielectric vor trebui sd apara dar nu este necesar sa fie partifionate suplimentar, e suficient Z Parts =
1.
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Nr |Cell [um]| NS | NZ | Mem. [MB] | Timp/f [s] C-F[’F?;]ME Obs.

1 8 4 0 46 6 0.8483 fér_evl Dielectric
Brick

2 8 4 |1 150 13 0.8882

3 8 4 | 2 272 22 0.8882

4 8 4 | 4 629 60 0.8882

Tabel 6. Analiza de convergenta, partitionare pe verticala a "Dielectric Brick" (Z Parts)

C_PRIME (Z Parts)

0.9 700

[+-C_PRIME
“#Memorie [MB]
| Timp/f[s]

=
=)
S

0.89

0.88

7]
=]
S

0.87

-
S
=1

Memorie [MB]|

[pF] 036

Timp [s]

w
=
S

0.85

»
2

0.84

-
e
S

0.83

0.82 0
0 1 2 4
Z Parts

Fig. 29. Analiza de convergenta, partitionare pe verticala a "Dielectric Brick" (Z Parts)

In acest moment se cunoaste ci e nevoie de metalizare "Thick Metal" cu 4 nivele de metalizare, blocuri
de dielectric fara sectionare suplimentara (Z Parts = 1) si o dimensiune a celulei de ordinul 8-4-2pm.
O analiza de convergenta pe structura completa (figura 26) este necesara pentru o decizie finala asupra
dimensiunii celulei. Rezultatele unei astfel de analize sunt prezentate in tabelul 7 si figura 30. Se
utilizeaza marimile (Num. Sheets si Z Parts) determinate anterior si se variaza dimensiunea celulei.
Variatia se opreste la celuld patrata cu latura de 2um, necesarul de memorie pentru a realiza analiza
cu o celuld de 1um fiind prea mare pentru a efectua calculele (61565MB). Variatia capacitatii primare
de la 8 la 2um este foarte mica (0.24%) deci inclusiv analiza cu celula de 8um ofera valoarea acestei
capacitati cu precizia dorita.

Nr |Cell [um]| NS | NZ | Mem. [MB] | Timp/f [s] C—F[’EF']ME
1| 8 4| 1 150 13 0.8882
2 | 4 4 |1 724 80 0.889
3| 2 4| 1 5540 2012 0.8904

Tabel 7. Analiza de convergenta, dimensiune celuld, cu "Dielectric Brick"
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C_PRIME (Cell Size)

0.891 6000
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Fig. 30. Analiza de convergenta, dimensiune celula, cu "Dielectric Brick"
Putem pastra ca analiza finala pe cea corespunzatoare celulei de 2um deoarece:

e a fost deja realizata
e chiar daca precizia de determinare a capacitatii nu a fost prea mult imbunatatita, un efect se
poate observa la nivelul elementelor parazite din schema.

Reprezentarea valorilor elementelor parazite pentru toate analizele mentionate anterior sunt prezentate
in tabelul 8 si figura 31.

NF [ifl'l'] NS[NzZ| Lm2 | LmM3 | cM2 | cM3 | R
1] 8 | 4| 0 | 002998 | 0.04836 | 0.06003 |0.002304| 1.459
2 | 4 | 4 | 0 | 002969 | 0.04786 | 0.06016 |0.002467 | 1.47
3| 2 | 4| 0| 00295 | 00476 |0.06019 |0.002602| 1.476
4| 1 | 4 | 0 | 002958 | 0.04747 | 0.06021 |0.002671| 1.485
5 | 4 | 0| 0 | 002721 | 0.05065 | 0.06088 |0.001595| 1.648
6 | 4 | 0| 0 | 003019 | 0.04919 | 0.06013 |0.001923| 1.371
71 4 | 0| 0 | 002745 | 0.05059 | 0.06093 |0.001625| 1.734
8 | 4 | 0| 0 | 00304 | 0.04916 | 0.06018 |0.001952| 1.455
9 | 4 | 2 | 0 | 002989 | 0.04784 | 0.06014 |0.002482| 1.475
0] 4 | 8 | 0| 00297 | 004778 | 0.06018 |0.002467| 1.487
11| 4 | 16| 0 | 002977 | 0.04773 | 0.06019 |0.002467| 1.512
12| 8 | 4 | 1 | 003094 | 0.04772 | 0.05982 |0.002447 | 1.366
13| 4 | 4 | 1 | 003067 | 004721 | 0.05996 |0.002613| 1.378
14| 2 | 4] 1 | 003046 | 0.04697 | 0.06001 | 0.00273 | 1.383
15| 8 | 4 | 2 | 003094 | 0.04772 | 0.05982 |0.002447 | 1.366
16| 8 | 4 | 4 | 003094 | 004772 | 0.05982 |0.002447 | 1.366
17| 05 | 4 | 0 | 002963 | 0.04738 | 0.06023 |0.002692| 1.491

Tabel 8. Analiza de convergenta, valori elemente parazite
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Fig. 31. Analiza de convergenta, valori elemente parazite

Se observa ca valorile elementelor parazite sunt consistente intre analize pentru elementele reactive,
cu exceptia pierderilor in structurd caracterizate de rezistenta serie, a carei valori depind destul de mult
de modelarea pierderilor prin metalizari si de prezenta pasivizarilor de SizsN4 aplicate pe metalizari
(reprezentare pe axa secundara din dreapta in fig. 31). Mai ales valoarea rezistentei beneficiaza de
micsorarea celulei la 2pum (index 14 1n tabelul 8), rezistenta crescand cu 1.25% fatd de analiza cu 8um
celula.

Note finale

e Pentru interpretarea timpului necesar pentru analiza si scalarea acestui exemplu la sistemul de
calcul propriu: analizele au fost realizate pe un sistem cu doud microprocesoare fizice X5450
@ 3.00GHz, fiecare microprocesor avand 4 nuclee fizice distincte. Fiecare din cele 8 nuclee a
fost folosit in proportie de 100% pe parcursul analizelor. Memoria fizica prezenta: FB-DDR?2,
32GB @ 333MHz, sistem de operare Windows 7, 64 biti.

e Optimizarile in Advanced Design System au fost realizate folosind metoda "Gradient",
Number of Iterations:1000, dmag:0.01, dphs:0.1 . Valorile obtinute nu sunt mai precise (in
limita atinsa la analize: 1%) si nu justificd obligatoriu alegerea acestei metode pentru
optimizare. A fost aleasa deoarece spre deosebire de utilizarea analizei "Random"” rezultatele
sunt repetabile (fira implicarea numerelor aleatorii). In general se poate utiliza fara probleme
"Random" cu un numar mai mare de iteratii (10000) deoarece algoritmul de optimizare este
mult mai rapid.

e Majoritatea timpului total de analizd a fost folosit pentru cele doud analize cu necesar de
memorie ridicat, ca urmare recomandarea de a realiza majoritatea analizelor de convergenta
pe modele simplificate la maxim oferd un castig de timp destul de ridicat. In exemplul
prezentat se observa ca la investigarea unui parametru (C, NS, NZ) ceilalti doi sunt redusi la
minimul posibil.

e Respectarea inifiala a indicatiilor cu privire la alegerea dimensiunilor celulei in functie de
dimensiunile fizice din circuit si relativ, pe cat posibil, la puterile lui 2, reduce extrem de mult
timpul consumat cu desenarea schemei pentru multiplele structuri din analiza de convergenta.
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Simulatorul din Sonnet are prevazutd functionalitatea de rulare automata, succesiva a mai
multor proiecte (fig. 32 - butonul Batch List). Se pot salva mai multe proiecte fara a realiza si
simularea (diverse dimensiuni de celula, numar de straturi, de nivele de metalizare etc.), iar cu
"Add Project" se pot adauga in lista, chiar si in timp ce un alt proiect este analizat. Acest lucru
ofera posibilitatea de a folosi timpul 1n care calculatorul simuleaza un proiect pentru a desena
un altul si a-1 adauga la lista s.a.m.d. (! util mai ales daca simulatorul nu reuseste sa foloseasca

100% toate procesoare existente)

Informatiile despre Memorie/Timp se pot obtine din simulator > butonul "Timing Info" sau
dupa simulare, din orice program din suita Sonnet din meniu: "Project > View Log > Timing

Info"
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Fig. 32. Simulator Sonnet em, lista de proiecte (Batch List)
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